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Experiment 4 
Analysis by Gas Chromatography 

 
In this experiment we will study the method of gas chromatography.  Gas chromatography (GC) is one of the 
most important analytical tools that the chemist has.  In this lab you will watch and listen to a video 
presentation about GC, look at a research-level GC instrument, and learn how to do a qualitative and 
quantitative GC analysis.  A schematic outline of a typical instrument is shown below. 
 
When a sample is injected into the correct column, a carrier gas sweeps the sample through the column.  If 
necessary, an oven heats the system to vaporize the sample and speed its passage through the column.  The 

different components of the sample 
will be separated by the column  

 

 

 

 

 

because each of the components “sticks” to the liquid coating that on  the column packing differently.  The 
greater the “stickiness,” the longer it takes for a substance to pass through the column.   

When a substance leaves the column, it is sensed by a detector.  The detector generates a voltage that is 
proportional to the amount of the substance.  The signal from the detector is then displayed by a chart 
recorder and/or fed into a computer.   

Modern gas chromatographs are connected to a computer which displays the peaks of all the substances in the 
sample.  This is called the chromatogram.  Software can perform all the calculations you will do in this 
experiment.  An example of an analysis for cholesterol esters is shown above.  If it could be done at all, this 
separation would take weeks by traditional wet chemistry.  Here it took 21 min for the analysis and a few 
hours to prepare the sample for injection into the chromatograph. 

However, so that you can understand how the computer does its analysis, we will supply you with peaks 
drawn by a chart recorder and you will perform all the measurements and calculations. 

The kind of signal displayed by a chart recorder is more-or-less a triangular shaped peak.  This is because the 
detector signal causes a vertical deflection of the recorder pen at the same time that the chart paper is moving 
under the pen 

The time that it takes a substance to pass through the instrument from injection to detection is called the 
retention time, tr.  The retention time, tr, is measured from the injection point to the peak height.  The peak 
height is the highest point of the peak and is the only reproducible point on the peak.  Since the chart paper 
moves at a constant speed, the box divisions are proportional to tr and you can measure tr in box divisions for 
this experiment. 

The amount of substance in a sample is proportional to the area under the peak of that substance.  However, 
the proportionality constant is different for each substance and detector.  Therefore, to do quantitative analysis  



  

 

 

 

 

 

 

 

 

 

 

by gas chromatography, you must first determine the proportionality constant for each substance in the 
sample.  You will do this by constructing calibration lines as described below. 

There is another piece of information that you need in order to do quantitative GC analysis.  This is the 
attenuation (attn).  Since most signals from the detector are too large for the recorder mechanism to handle, 
there is a switch on the chromatograph that attenuates or reduces the size of the signal.  For example, if the 
attenuation of a peak is 512, the signal has been reduced 512 times.  So you must multiply the area under the 
peak (the area that you measure on the chart) by 512 to get the true area that is proportional to the original 
signal.  Thus, it is area x attn that is proportional to the amount of substance injected.
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You will be given a packet in lab that contains copies of GC chart recordings of the following four 
compounds: 

 

 

 

 

There are two kinds of information available on the recordings in the packet. 

1.  The retention times of each substance as determined from the distance in box units between the injection 
point and peak of each curve.  As stated above, we will use box units for retention times because they are 
proportional to the time and serve us just as well. 

2.  The peak areas corresponding to injection of different amounts of each pure substance. You are given a 
number of peaks (usually 7 or 8) for each pure compound made by varying the quantity (in microliters, µL) 
injected, and the attenuation setting for each peak. 

You are to plot a calibration line for each substance using Vernier’s Graphical Analysis program.  You will 
then perform a linear regression on each line to determine the slope and y-intercept of the line.  After the 
calibration lines are plotted and approved by the instructor, you will be given the chromatogram of an 
unknown mixture to identify.  By determining the retention time of each peak of the unknown, you can 
identify the substance that the peak corresponds to.  By measuring the area x attn of each peak, you can use 
the formula of a straight line  (y = mx + b) from the calibration line to determine how much of each substance 
was injected.Determining Retention Times and Preparing Calibration Graphs   

On the chromatogram of all the pure substances (the last page of the packet you will be given in lab), measure 
the retention time of each peak in box units, to the nearest 0.1 box units, and record it directly on the graph 
near the peak.  For each peak, the retention time is measured from the injection point to the top of the peak as 
shown below.  Transfer the values to Data Table – Retention Times. 

 

 

 

 

 

Open Graphical Analysis.  Using Graphical Analysis, you will plot the area x attn on the vertical axis (the y-
axis) and the microliters ( µL) injected on the horizontal axis (the x-axis).  A separate graph will be prepared for 
each substance.    You will end up with four separate graphs containing four straight lines, one for each substance.  
These will be your calibration lines. 

Using Graphical Analysis to Plot Your Data 

1.  Enter the data into the Data Table Window.  You can move from one cell to another by hitting the Enter 

tr 
start 



  
button on your keyboard, or by using the mouse to click on the cell.  Microliter (µL) values are entered in the 
column labeled x.  Area x attn values are entered in the column labeled y.  Since the area x attn numbers are 
very large, they should all be converted to scientific notation and then changed so that all the numbers have 
the same exponent.  Choose this one exponent so that all the number parts are larger than 1 but otherwise as 
small as possible.  Then you can just plot the number part (the abcissa) and note the exponent (the ordinate) 
on the y-axis label.  Suppose two of your numbers are 35,600 = 3.56 x 104  and 274,000 = 2.74 x 105.  For 
plotting purposes, you would write them as 3.56 x 104 and 27.4 x 104 and only plot 3.56 and 27.4. 

2.  Click on the graph’s title and change the title to the name of the substance plotted.  For example, the first 
graph will probably be called “Benzene” or even better, “Calibration Line for Benzene.”  At this point, you 
should sort the data so it is listed from the smallest volume to the largest volume.  This is so the entries in the 
Data Table Window are easy to read.  Do this as follows:  Make the Data Table Window active by clicking on 
it.  Then Data  Sort Data  Volume  OK. 

3.  Double click on the x in the Data Table Window and change 
the axis label.  Label the x-axis volume injected with units of 
µL.  Now label the y-axis by double clicking on the y in the 
Data Table Window.  For the numbers shown in #1 above, you 
would label the y-axis area x attn x E–4 in units of boxes.  
(You can’t enter exponents in a graph title or an axis label in 
this program, so use E–4 to mean 10–4.  The E stands for 
exponent, in this case 10.)  The reason the exponent is 10–4 and 
not 10+4 is that you multiplied the original numbers by 10–4 to 
get the numbers written on the y-axis.  This is the convention 
that is used in scientific journals. 

4.  Make the graph the active window by clicking any place in 
the graph.  Remove the connecting line on the graph by un-checking Connecting Lines in the Graph menu.  
Perform a linear regression on each graph in the following way:  In the Analyze menu, select Curve Fit.  
Choose Linear in the resulting window, and then click try fit and then OK.  Move the regression box on the 
graph away from the line so the line and the points are not covered.  Do this by placing the cursor anyplace in 
the regression box, and while holding down the left mouse button, move the mouse to reposition the box.   A 
typical calibration graph for benzene is shown above.   

5.  Print each data table and calibration graph in the following way:  First fill in the Text Box on the screen 
with your name, course, section, name of lab experiment, and date.  Generally, the landscape orientation is 
preferable to portrait.  Landscape can be selected in page setup menu under file.  Choose Printer Setup in the 
File menu.  Choose the correct printer for your lab as directed by your instructor.  Click OK.  Then choose 
Print in the File menu.   

6.  Saving your data:  Insert a formatted 3 ½ in. floppy disk into the a: drive.  In the File menu, click on Save 
As.  In the Save Data As window, and then in the Filename: box, erase any existing file name and type in 
your file name, such as GC benzene.  Then click OK.  You have now saved the graph for benzene.  Save the 
3 other graphs in a similar way. 

Show your calibration graphs to your instructor who will then give you a GC recording of an unknown. 

Analyzing Your Unknown 

Determine the retention time in box units of each peak in the unknown.  Identify each substance present by 
comparison with the retention times of the substances contained in the chromatogram of all the pure 
substances.  Enter the retention times in the Data Table—Retention Times opposite the substances you have 
found in your unknown.   
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To find out how many microliters of each substance was injected, let’s first look at the calibration graph of 
benzene on page A-5.  Assume that an unknown contains benzene for this example.  From the calibration 
graph for benzene, the equation for the calibration line (from the regression box) is 

y = Mx + B 

y  =  11.5 x  +  3.45 

where x represents the number of microliters of benzene and y represents the area x attn for the benzene 
curve.  Since all the y-axis values on the graph had been multiplied by 10–4, the slope and intercept now need 
to be multiplied by 10+4 to get back to the original numbers.  Thus the equation you will use to find the 
number of microliters of benzene is 

y  =  11.5 x 104 x  +  3.45 x 10+4 

Suppose that the area x attn that you measured for benzene on the unknown is 197,000 boxes.  This value is y 
in the above equation.  To find the number of microliters of benzene injected, solve for x. 

4

4

y -3.45x10x=
11.5x10  

Substituting y = 197,000 boxes into the above equation gives x = 1.41 µL.  Thus 1.41 µL of benzene was 
injected for this unknown. 

Now, for your unknown, measure the area under each curve as was done for the pure substances.  Multiply 
area x attn for each peak and use the appropriate calibration curve to determine the number of microliters of 
each pure substance that is present in the unknown sample.     

The sum of the microliters of all substances in your unknown is the number of microliters of the unknown 
sample that was injected into the gas chromatograph.  Find the percent of each substance in your unknown by 
using the following formula: 

µL of one unknown x 100 = % of the unknown
µL total injected

 

Enter your percents in the Results Table. 
 
Your report 
Include copies of all data sheets, your 4 calibration graph screens, your unknown chromatogram, all 
calculations that you used to determine the percent composition of your unknown, and the next page.  Don’t 
hand in the yellow packet given out in lab. 



  
 

Experiment 4 Gas Chromatography 
Data Sheet 

Name         
 
Retention Times 

Substance Retention time from known  Retention time from your unknown.  Only 
substances present should be entered.   

benzene   
toluene   
ethylbenzene   
mesitylene   
 
Benzene 

Peak 
Height  

Width at 
½ height, 
W1/2  

Area  Attn Area x 
attn  

Area x attn 
in scientific 
notation  

Area x attn 
with all the 
exponents the 
same  

Volume 
injected 
(µL) 

        
        
        
        
        
        
        
        
 
Toluene 

Peak 
Height 
(boxes) 

Width at 
½ height, 
W1/2 
(boxes) 

Area 
(boxes) Attn 

Area x 
attn 
(boxes) 

Area x attn 
in scientific 
notation 
(boxes) 

Area x attn 
with all the 
exponents the 
same (boxes) 

Volume 
injected 
(µL) 
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Experiment 4 Gas Chromatography 
Data Sheet 

Name         

Ethylbenzene 

Peak 
Height 
(boxes) 

Width at 
½ height, 
W1/2 
(boxes) 

Area 
(boxes) Attn 

Area x 
attn 
(boxes) 

Area x attn 
in scientific 
notation 
(boxes) 

Area x attn 
with all the 
exponents the 
same (boxes) 

Volume 
injected 
(µL) 

        
        
        
        
        
        
        
        

Mesitylene 

Peak 
Height  

Width at 
½ height, 
W1/2  

Area  Attn Area x 
attn  

Area x attn 
in scientific 
notation  

Area x attn 
with all the 
exponents the 
same  

Volume 
injected 
(µL) 

        
        
        
        
        
        
        
        
 
Results Table  

Identity of each 
substance in unknown 

Area x attenuation 
of each unknown 

Volume of each unknown           

(µL) 

% of each 
substance in 

unknown 

    

    

    

    

 

 


